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Chapter 1

CharGen

1.1 CharGen Documentation

CharGen - An AD&D Character Generator
Version 1.17
21. september 1994
by
Troels Poulsen

Introducing CharGen
General notes
Disclaimer

The CharGen package
Installation of CharGen
Important !!!

Keyboard shortcuts

The character sheet
Sharing files with others
Online help

The Project menu

The Edit menu

The Equip menu

The Abilities menu
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The Design menu
The Settings menu
Tool Types
Program Limitations
History
Contacting the author
Support
Thanks to...
1.2 introducing

CharGen is a character—-generation program that lightens the workload
of the Dungeon Master in the roleplaying game >Advanced Dungeons &
Dragons< (also known as AD&D) from TSR Inc.

If you have no prior knowlegde of AD&D, the program will _not_ be of
any great use to you. The program does _NOT_ replace any puplished
material from TSR, i.e. you cannot learn the game from this program,
nor can you learn the spells contained in the different source books
from this program.

CharGen is FreeWare :-)

1.3 general
Be sure the settings in the Settings menu corresponds to the <=

rules
you use in your game, as this can influence the way certain rules are
applied. If you cannot recreate a character from your game, check the
menu items in the Settings menu.

Do not use the '@’ character, as this is used to embed printer
escape sequences in your character sheet. If you do use it, there is a
high propability that it will mess up your character sheet (or even
crash the program if you are very unlucky!).

In CharGen you will sometimes see a recessed gadget showing a number,
with a integer gadget to the right of it, such as the pair shown under

Edit/Level and Xp
The first of these shows the total number (in this
case the total number of hit points), and the second the adjustment you
have applied (a kind of ’‘cheat’ gadget).
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It is important for you to know that an adjustment entered into
CharGen will be shown with a "+’ or a "—-’.

A '+’ should be taken to mean that it is a bonus, and a -’ means
that the number is a penalty. Thus if you enter +2 in the THACO
adjustment gadget, under

Abilities, Fighting
you will see the
THACO _decrease_ by 2.

Under some of the very long scrolling lists you will find a string
gadget named ’'Find’. This gadget is a search gadget that allows you to
enter a piece of text to search for. If the text piece is found, it
will be the new top item in the list. The search ignores case, and
doesn’t need the full text (e.g. When searching the priest spell list
for cure spells you can enter ’‘cure’. You will then see the next spell
with the letters ’cure’ in its name at the top of the list - this
could be one of the Cure xxxxxx Wounds spells, or even the Obscurement
spell).

The search routine will wrap around, when it finds no matching name
in the list below the present top.

Development on the present version of CharGen has stopped. If a future
version of CharGen is relseaed it vill be a WB 2.x+ version.

1.4 disclaimer

DISCLAIMETR

This program may not be sold, or otherwise distributed for financial
gain. Please remember that this program is supplied 'as is’: the
entire risk as to the quality of the program is to the user. In no
event will the author be liable for direct or indirect damage or loss
resulting from the use of this program.

1.5 package

File Contents

in the CG dir...

CharGen The program

CharGen.doc This file

History.doc Update history for the CharGen package
CharData A directory

libs13 A directory

1libs20 A directory

Install_ReqgTools An Install script for regtools.library.

in the CharData dir...
Race Datafile for CharGen
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Class Datafile for CharGen
Major Class Datafile for CharGen
Armor Datafile for CharGen
Weapon Datafile for CharGen
Proficiency Datafile for CharGen
Spells Datafile for CharGen
Wizard Schools Datafile for CharGen
Priesthoods Datafile for CharGen
Psionics Datafile for CharGen
Sources.prefs Settings file for CharGen
CharGen.prefs Settings file for CharGen
CharIcon.info Icon used by CharGen for character files.
in the 1ibsl3 dir...
regtools.library Requester library for 1.3 by Nico Frangois.
in the 1ibs20 dir
reqgtools.library Requester library for 2.x by Nico Frangois.
1.6 installation
The following file structure must be kept so that CharGen can <+
find
it’s data (or you can use the
SETTINGS
4
CHARDATA
and
CHARACTERS
tool types).
CharGen

Characters (Dir) =«
CharData (Dir) =*=*

*)

Armor

Class

Major Class
Priesthoods
Proficiency
Psionics

Race

Spells

Weapon

Wizard Schools
CharIcon.info
Sources.prefs
CharGen.prefs #*x*x*

Must be named Characters, and must be in the same directory as

CharGen, unless the

CHARACTERS
tooltype says otherwise. This is the

initial directory. You can off course load characters from any source.

* %)

Must be named CharData, and must be in the same directory as
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CharGen, unless the
CHARDATA
tooltype says otherwise.

*%%) Must be in the CharData directory, and must be named
CharGen.prefs, unless the
SETTINGS
tooltype says otherwise.

You can still load characters created with earlier versions of
CharGen, but you might see minor changes in you character. You should
read the History.doc to see what you can expect, when you load an old
character into CharGen.

In addition CharGen needs the following libraries, which must be the
LIBS: directory.

info.library - Get this from your workbench disk.
diskfont.library - Get this from your workbench disk.
regtools.library - Use

Install_ReqgTools

script to install

1.7 important

CharGen uses the RegTools.library © by Nico Frangois to gain a
Workbench 2.0-look on it’s requesters, even under Workbench 1.3.
CharGen must have at least version 2.0a of this library to function
correctly.

You must install the ReqTools.library in your LIBS: directory. Use
the Install_ReqgTools (by double-clicking it) script for this, since
there are two versions of the library (one for 2.0+ and one for 1.3).
If you are running Workbench 2.0 or lower, Jjust use the
Install_ReqgTools script. If you are running under Workbench 2.1 or
higher, get hold of the ReqTools package (version 2.0a or higher), if
you would like to ’localize’ ReqgTools. Many

thanks
to Nico
for this great library.

1.8 shortcuts

In order to cut down on the number switches between the keyboard and
the mouse you have to make, CharGen provides you with the following
keyboard shortcuts:

All versions of WB:

If no string gadget on the screen is activated, and you press
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<RETURN>, the first string gadget (if there is one) on the screen
will activate.

When you use <RETURN> to exit a string gadget, the next gadget (if
there is one) will be activated.

When using <RETURN> (and <SHIFT><RETURN>, see below) to walk among
the string gadgets on the screen, CharGen will wrap around when
reaching the last/first string gadget (i.e. if you press <RETURN>
in the last string gadget, then the first string gadget will be
activated and vica versa).

WB version 2.0 and up:
If you use <SHIFT><RETURN> instead of just <RETURN> when exiting a
string gadget, the previous string gadget (if there is one) will
be activated, not the next.
You can make a cycle gadget cycle the opposite way by holding down
the <SHIFT> key while clicking it.
The up/down cursor keys can be used to scroll through a scrolling
list. If there are two such lists on screen at any one time, the
second can be scrolled by using the right/left cursor keys. It
only works if no string gadget is active on the screen at the same
time.
When using the arrow gadgets of a scrolling list, or the cursor
keys, pressing <ALT>, <SHIFT>, or <CTRL> on the keyboard has this
function:
<ALT> : Move by a half view full.
<SHIFT>: Move by one view full.
<CTRL> : Move to start or end of list.
Keybord equivalents for the Ok, Cancel, Continue, and Find gadgets
shown on many screens are implemented:
<o> ok
<ESC> cancel
<o> continue
<f> find
If a string gadget is active <right amiga> and the key will work as
the keyboard equivalent.
(I haven’t used <c> as "cancel” to avoid conflict with the StringClip
program, which is quite useful in conjunction with CharGen.)
1.9 sheet
Following is a description of the abbreviations used on the
character
sheet.

Ability Scores

Saving Throws
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Weapons

1.10 abbr_ability

Ability Scores

Str Strength

Reaction

Attack

Defensive
Con

Hp

System

Resurrect

Languages

Wis Wisdom

To hit bonus
Damage bonus

Weight allowance

Open

doors

Bend bars/Lift gates
Dex Dexterity
Reaction adjustment
Missile attack adjustment
Defensive adjustment

Constitution

Hit point adjustment

System shock

Resurrection survival
Int Intelligence

Number of languages and bonus proficiencies

Cha Charisma

Henchmen
Reaction
Loyal

1.11 abbr_saving

Saving Throws

Maximum number of henchmen
Encounter reaction adjustment
Loyalty adjustment

Com Comeliness

PPD Paralyzation, poison, or death magic

RSW Rod, staff, or wand

PP Petrification or polymorph

BW Breath weapon

SP Spell

Dogde Bonus on saves that dexterity affects

Elec Bonus on saves versus electricity

Fire Bonus on saves versus fire

Mind Bonus on saves versus mind affecting magic
Pois Bonus on saves versus poison

1.12 abbr_weapons
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Weapon
Skl Skill
Nonproficient
Prf Proficient
Spc Specialist
Stl Fighting style
WS Weapon & shield style
1w Single weapon style
2H Two hander style
2W Two weapon style
Hnd Hand
P Used in primary hand
S Used in secondary hand
B Used in both hands
Hit Roll needed to hit AC 0 (THACO, but this was to long)
Att Attacks per round

Damage Damage done
Special Special notes:
"S M L Range in tens of yards (Short/Medium/Long).
If a weapon has a range, it is calculated
as a missile weapon.

"-X AC’ AC bonus of X.
"+Shield’” Bonus shield attack each round.
"+Dam’ Possibility of extra Firearm damage.

THACO To Hit Armor Class 0. This is the base value as
opposed to "Hit’ which is the wvalue adjusted for skill,
magic and other things.

1.13 sharing

If you play in a group where several others also have CharGen,
and
you want to be able to share character files between you, there are
several steps you must take avoid problems:

Make sure you are all using the same (and newest) version of CharGen.

Make sure the datafiles are identical. This is only a problem if
somebody in the group wish to design something. Appoint one of you
to have the ’"Master files’ and design everything here. Then make
copies of the master files (the

CharData

directory) and distribute
them.

There are two reasons that the latter is nessesary. The first is
simple, the second complex:

If a person designs something and uses it in a character which he
then saves and gives to another, the other person’s CharGen will have
no information about the data the first person designed (while this
could be a minor problem if it was a spell, imagine trying to load a
character of a class that doesn’t exsist in your system - CharGen

(_)
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would simply refuse to load the character).

CharGen gives each data item (a spell, a weapon, or whatever...) a
identification number. If two people independently designs something
(e.g. a spell) it will have the same identification number, even
though they are very different (one could be a 1’st level spell, the

other a 9’th level). When a character is saved, only the
identification number of his data items are saved, and not the data
itself (would result in _very_ large files for spellcasters). So when

a character, who can cast the 1’st level spell designed on the first
system, 1s saved, and later loaded on the second system the character
can now cast a 9’th level spell.

1.14 cg_help

Pressing the <HELP> key under WB 2.04+ will bring up the CharGen
documentation file via AmigaGuide on the CharGen screen. To use this
feature you must have the amigaguide.library installed.

If you enter a menu item (such as ’'Weapons’ in the ’'Equip’ menu) and
press <HELP> you will be given information about that menu item’s
function.

If you select a menu item and press <HELP> (while still holding the

right mouse button depressed over the menu item) you will be given
information about that menu item’s function.

1.15 project

The Project Menu

Enter
Random
Open
Save

Save As
Print

Character
Description

Spells
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Psionics
About

Quit

1.16 project_enter

Project/New/Enter

Allows you to create a person from scratch. You are guided through
most menu-items in the
Edit
4
Equip
, and
Abilities
menus.
You can cancel at any time by clicking CANCEL.

1.17 project_random

Project/New/Random
Creates a random character, taking into account the frequency of the
different Races, Classes etc... You are first asked to set certain

variables which also affect the result.

These are the chances for the different frequencies:

Common 65%
Uncommon 30%
Rare 4%
Very Rare 1%

So if you would like to have more half-elves when rolling random
characters simply change the frequency of half-elves in the Design
Race menu (and so on...).

1.18 project_open

Loads a character from disk.

1.19 project_save

Saves a previously saved character.
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1.20 project_saveas

an

Saves a new character. Brings up a filerequester so you can select
other filename.

1.21 project_character

in

be

Prints a character-sheet (normally to PRT:, but this can be <+

changed

Settings/Printer
) using standard Amiga printer control codes.
To get a good looking result the left margin in prefrences should
set to about 5.

1.22 project_description

Prints a characters description, notes and equipment seperatly.

1.23 project_spells

Prints spellslists/spellbooks. Please note that this menu item
only

functions when the current character is a spellcaster.

Here is a short summary of what different methods prints:

"User defined format’
You can define how this should work in
Settings/Format/Spells

"Standard format’
Name, Range, Duration, Area of Effect, Casting Time, Save,
Reversability, and Components.

"Spellbook format’
Name, Range, Duration, Area of Effect, Casting Time, Save,
Reversability, Type, Source Book, Components, and Pages (a line).

"Names and components’
Name, Components, Left (a line), Used (a line), and Material
Components.

"Names in 1 column’
"Names in 2 columns’
"Names in 3 columns’
"Names in 4 columns’
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You can define how this should work in
Settings/Format/Spells

1.24 project_psionics

Prints psionic power lists. Please note that this menu item only
functions when the current character has psionic powers.

Here is a short summary of the method:

Name, Type, Power Score, Initial Cost, Maintainance Cost, Range,
Preparation Time, Area of Effect.

1.25 project_about

Shows some details about CharGen (version number and date),

how

contact me

1.26 project_quit

Guess what this will do...

1.27 edit

The Edit Menu
Race and Class
Ability Scores
Level and Xp
Saving Throws
Description

Notes

and <
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1.28 edit _race

Choose Race and Class. If you already have a character this should
be done with great care, since it can change (or even delete) other
parts of the character which are illegeal for the new Race/Class
combination.

The total xp of the character remains unchanged.
Wizard types and Priesthoods are also chosen here, if more than one
is allowed. If only one is allowed, you will not be asked which one

you want (e.g. the wizard type of an elven fighter/wizard is always a
mage, unless you have designed some wizard schools yourself).

1.29 edit_ability

This is where you choose Strength, Intelligence etc...

On the left there are seven boxes containing the present ability
scores (and one for exceptional strength). It is these scores you will
get when you press the OK box. They can be altered by clicking the
appropiate box and entering the desired score. This can override the
Min-Max range shown next to it.

Below is a gadget labeled ’'Enforce Ranges’. If you click this, the
ability scores will be adjusted so that they fall into the ranges
shown. Please note that these are not the same as those in the PHB.
They are the _effective_ limits, meaning that they have been adjusted
by the racial ability score adjustment, to reflect the true range
allowed (the ranges shown in PHB must be imposed _before_ racial
ability adjustments are added).

Below this is a gadget labeled "Reroll Ability Scores’. If you click

this, the ability scores will be rerolled (surprise!), using the
method you have chosen in
Settings/General

Method: PHB 1 and UA
There are no further gadgets on screen when you use these methods.

Method: PHB 2, PHB 3, PHB 4, PHB 5, and Custom.

On the far right are 7-14 boxes. These contain random numbers
generated by rolling according to the chosen method (either 3d6, or
4d6 and discarding the lowest roll, or as defined in the

Settings/General

menu) . If you click on one of these boxes it will
be highlighted. This indicates that you are about to place that
number on one of the ability scores, which is done by clicking on one
of the gadgets with the name of the appropiate ability score. If you
want to place a number on another ability score, simply click the
gadget with the number, and it will become free to be placed somewhere
else. Method PHB 2 is a little special, in that you can only place a
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number on the ability score that is on the same level with it on the
screen.

If the above explanation confused you even more, then try it out,
and see what happens.

The methods have been extended (from those explained in PHB) to also
take comeliness into account.

The adjustment of Comeliness for high or low Charisma is not
performed until the character sheet is shown or printed.

1.30 edit _level

Enter your characters level and xp. You can change the hit points by
using the ’REROLL’ button, or directly entering the hit dice rolls for
each level. There is also a ’cheat’ gadget that allows you to add hit
points directly.

1.31 edit_save

Allows you to review/alter the characters saving throws. The
"Protection’ box simulates the effect of a Ring of Protection as it
affects saves. It has no influence over the armor class of your
character.

1.32 edit_description

Allows you to enter a short/long description of the character in
question.

1.33 edit _notes

Here you can enter various notes for your character. If you don’ <
t
see these written at the bottom of the sheet, check that the

Show notes and equipment
option in the
Settings/Format/Character
menu is on. If it is on and you still don’t see it try, turning

Show full description

in the same menu off, or make the sheet
longer by increasing

Sheet Length
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1.34 equip

The Equip Menu

Armor
Weapon
Magic Items
Equipment

Wealth

1.35 equip_armor

Choose the armor for your character. Some armors may be
disallowed

because of the characters class, or priesthood. If you have selected
the option

Piecemeal armors allowed

under

Settings/Options/This character

4
and your present character is allowed to use armors that can be used in
pieces, you will be presented with five extra cycle gadgets to control
the makeup of your armor.

1.36 equip_weapon

Choosing a weapon
You choose a weapon by clicking on it in the scrolling list named
"Available Weapons’. When you do this, the weapons name will appear in
the ’'Chosen Weapons’ box, which is the weapons which will be shown on
the character sheet. Below it are these gadgets:

Edit

Copy

P
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Swap

Remove

1.37 equip_weapon_edit

Press the Edit gadget, then select any weapon in the list above.

This gadget can be used on any weapon displayed in the ’Chosen
Weapons’ box, and gives you extensive control over the characters skill
with the weapon in question.

Editing a weapon

Most of the gadgets that appears, when you have chosen Edit and
clicked on a weapon in the ’'Chosen Weapons’ box, need no further
explanation, so here are just a few notes to help you:

Skill
Style
Combat
#AtLtL
Special

A note about size

1.38 equip_weapon_edit_hints_skill

Even though you have a fighter, and have slots left, you might not
be able to specialize because you can only specialize once on level
one, and again each time you gain new weapon slots (i.e. every third
level).

1.39 equip_weapon_edit_hints_style

CharGen uses the fighting-system from ’'The Complete Fighter’s
Handbook’ - i.e. it is possible to use different fighting styles
(Weapon & Shield, One Weapon, Two Weapon, Two Hander). Some styles
might not be available due to restrictions on the Weapon (its hard to
use a Bow one-handed), or because of the characters class or height.
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1.40 equip_weapon_edit_hints_combat

Tells CharGen weather it should treat the weapon as a missile weapon
or a meele weapon. This is useful with weapons such as the dagger.

1.41 equip_weapon_edit_hints_att

This is the number of attacks per round the character has with <«
this
weapon. To the right is a number gadget that allows you to increase or
decrease the number of attacks, by entering a positive or negative
number. This is the possible values:

Nil, 1/4, 1/3, 1/2, 1/1, 3/2, 2/1, 5/2,
3/1, 7/2, 4/1, 9/2, 5/1, 5 %, 6/1

The rate of fire (ROF) for a weapon specialist using some missile
weapons have been set by me, when I could not find any relevant
information (in the case of the new firearms), or when the information
available didn’t make sense. If you disagree with any of my choises
simply change them via

Design/Weapon.. .

Here is a list of the changes:

The blowgun has a base ROF of 2/1, but if you specialize you
get a ROF of 3/2 (according to table 35 in Player Handbook),
which doesn’t make much sense.

The hand crossbow has the same ROF progression as ’Other
(Non-bow) Missiles’ in table 35 in Players Handbook.

The knife, shuriken, and stilleto has the same ROF
progression as the dagger.

The ROF progression for firearms has been based on the
weapon’s base ROF and the progression shown in table 35 in
Players Handbook for light and heavy crossbows, thus on
levels 1-6 the ROF 1is unchanged, on levels 7-12 it is one
step higher, and on level 13 and above is it two steps
higher.

1.42 equip_weapon_edit_hints_special

This is where CharGen writes special information. This could be the
range of a missile weapon, effects of style specialization, a reminder
of the possibility of extra damage with firearms and so on...

1.43 equip_weapon_edit_hints_size
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The size of a person (which is used for determining which weapons
can be used and how) is now calculated from the person’s height and
not from the average racial height, thus a very large (higher than 4’
= medium size) halfling can use a scimitar (also medium size). I have
used the height intervals from Monstrous Compendium:

Tiny : up to 27
Small : 2"+ to 4f
Medium : 4"+ to 7
Large : 7"+ and up

1.44 equip_weapon_copy

Press the Copy gadget, then select a weapon, then select an empty
line in the ’'Chosen Weapons’ box.

Lets you to make a copy of a weapon shown in the ’'Chosen Weapons’
box.

1.45 equip_weapon_swap

Press the Swap gadget, then select a weapon and then select another
weapon. The two weapons position will be switched.

Lets you to change the order the weapons in the ’Chosen Weapons’ box
will be shown on the character sheet.

1.46 equip_weapon_remove

Press the Remove gadget, then select a weapon to remove.

Lets you remove a weapon from the ’'Chosen Weapons’ box, and makes
you non-proficient with it, if it was the last of its type in the
"Chosen Weapons’ box.

1.47 equip_magic

This menu-item has not been implemented yet, but it’s on the way
(Lars), though it will take some time (Troels 8-).

1.48 equip_equipment
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Here you can enter various equipment for your character. If you
don’t see this info written at the bottom of the sheet, check that
the

Show notes and equipment

option in the

Settings/Format/Character

menu is on. If it is and you still don’t see it, try turning

Show full description

in the same menu off, or making the sheet
longer.

1.49 equip_wealth

Here you can enter the amount of money the character has, and in which
coinage it is.

1.50 abilities

The Abilities Menu

Fighting
Proficiencies
Spell Casting
Thieving Skills
Turning Undead
Psionics

Extra Abilities

1.51 abilities_fighting

Here you can choose which (if any) fighting styles the character is
specialized in. You can become proficient in whole groups of weapons, or
give your character ambi-dexterity as defined in ’'The Complete Fighter’s
Handbook’ and ’"The Complete Spacefarer’s Handbook’.

1.52 abilities_proficiencies
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Allows you to choose which proficiencies your character shall have.
You will notice that there are different colors on the lines in the
scrolling list of proficiencies. These colours relate to how many
slots the proficiency takes in the manner descriped on screen.

o Free proficiencies are just that, Free. They are available to your
character at no cost in proficiency slots.

o Normal proficiencies are those that your character can learn
normally, at the normal cost.

o Special proficiencies are those proficiencies that your character
needs to use an extra proficiency slot to learn.

1.53 abilities_spell

Allows you to choose the individual spells your character can cast.
Some spells may be unavailable due to various restrictions. You can
change the Settings and/or your character to make them available.

All normal spells from Players Handbook, Wizards Handbook, Tome of
Magic (not Quest spells), Greyhawk Adventures, and Forgotten Realms
Adventures, are available in CharGen, as are some spells from Dragon
Magazine. If you see a spell you cannot find anywhere, it is propably
one of my own creations.

Your chosen spells can then be printed using the Print Spells item
in the Project menu.

Please note a spell that normally (in AD&D books) start with the
name of its creator (fx. ’'Melf’s Minute Meteors’), do not do so in
CharGen. In CharGen the name of the creator is not part of the name of
the spell. So if you are looking for ’'Melf’s Minute Meteors’, you will
find it under ’'Minute Meteors’.

The random spell selector (when used by wizards), takes the
intelligence limit on spells into account, weather the character is a
specialist wizard (spells of his specialist area are made more
frequent), and selects the Read Magic spell.

If you have a character with several spellcasting classes (E.g. a

Ranger/Priest) you can switch between the different classes via the
cycle gadget labeled ’Spellcaster’.

1.54 abilities_thieving

If the character has any ’'criminal’ skills, this is where you edit
them.

The recessed box shows how many point you have left to distribute, and

the total number of points you may distribute.
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By clicking ’"Base Skill Points’ the points will be reset, to the
characters base points, adjusted for armor, race and dexterity.

By clicking ’Distribute Points’ the remaining points will be randomly
distributed among the skills.

1.55 abilities_turning

How good is your character at turning undead (requires a priesthood
that can turn undead, and sufficent level).

1.56 abilities_psionics

There are two way of giving your character psionic powers. The
first is by choosing the Psionicist character class, the second is by
making a Wild Talent. Simply click the ’'Wild Talent’ gadget to make
your character a wild talent.

The number gadgets labled ’'Dis’, ’'Sci’, ’'Dev’, ’'Def’, shows how many
disciplines, sciences, devotions and defense modes you can learn. If
you are a Psionicist the numbers shown will correspond to the table in
the Psionics Handbook. For wild talents you must enter the numbers
your self, as CharGen doesn’t select wild powers for you.

The number gadget labled PSP’ shows the number of Psionic Strength
Points your character has. For wild talents you have to enter this
your self.

Before you can choose any powers, you must have access to a
discipline. You gain acess to a discipline by selecting it from the
list ’"Clairsentience’, ’'Psychokinesis’, ’'Psychometabolism’,
"Psychoportation’, ’'Telepathy’,’Metapsionics’. The primary discipline
(the first one chosen) has its text written in black on blue
background, while the rest of the chosen disciplines are written in
white on blue background.

To the right of the chosen disciplines, are numbers that show the
number of sciences/devotions you have chosen in the corresponding
discipline. Please note that defense modes do not show up in the
number of sciences/devotions chosen, nor are they counted when
checking the rules.

Select ’"Learn’ to be able to select and unselect psionic powers. To
relearn a power select ’"Relearn’. To see information about a power
(including how many times you have learned it, if any) select
"Information’.

If you "unlearn" powers or whole disciplines, the rules for
selection given in The Complete Psionics Handbook are not checked. To
see if anything needs fixing, click on the ’'Check for problems’
gadget. This will test for most rule violations, but is not perfect
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(you still have to think ;-).

If you try learning a power but cannot, the reason is the rules
given in The Complete Psionics Handbook.

Psionicists generated randomly will not have psionic powers selected
for them. This should be done by you.

1.57 abilities_extra

As the name implies, where you enter all those extra special
abilities or notes, that CharGen does not otherwise handle.

1.58 design

The Design Menu

DANGER! !'!
Race

Class

Armor

Weapon
Proficiency
Spell
Priesthood
Wizard School

Psionics

1.59 design_danger

DANGEHR et

Using the items in this menu can have very sad consequences, so make
a backup of the CharData directory before you change anything.

As a general rule you should look at some examples before you try
designing on your own. Specificly you should keep in mind that:

o A race should have at least one class allowed.
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o If a class can cast priest spells you must make a priesthood
available to it, even if the class is not a priest (e.g. Paladins
and Rangers) .

o If a class can cast wizard spells you must make a wizard school
available to it, even if the class is not a wizard (e.g. Bards).

When you create new things by using this menu you may get the
message: 'Not room for more races !’ or something similar. The cure
for this is simple (assuming you have enough memory). Save all you
work, quit the program, and start it again. You will now have some
more working space.

1.60 design_race

Allows you to change the different races, or create new ones.

1.61 design_class

Allows you to change the different classes, or create new ones.
Please note that any new classes you create will not be available
until you make them so via

Design/Race

1.62 design_armor

Allows you to change exsisting armors, or create new ones. <
Please
note that any new armors you create will not be available until you
make them so via
Design/Class
and perhaps
Design/Priesthood

1.63 design_weapon

Allows you to change exsisting weapons, or create new ones. <
Please
note that any new weapons you create will not be available until you
make them so via
Design/Class
and perhaps
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Design/Priesthood

1.64 design_proficiency

Allows you to change exsisting proficiencies, or create new ones.

1.65 design_spell

Allows you to change the spell list. This is the ’'safest’ item
of
all the items in the in the
Design
menu.

1.66 design_priesthood

Allows you to change exsisting priesthoods, or create new ones.
Please note that _any_ class (i.e. not just priests) that can cast
priest spells should have at least one priesthood available to them.

1.67 design_wizard

Allows you to change exsisting wizard schools, or create new ones.
Please note that _any_ class (i.e. not just wizards) that can cast
wizard spells should have at least one wizard school available to
them.

1.68 design_psionics

Allows you to change exsisting psionic powers, or create new ones.

1.69 settings

The Settings menu

This Character

New Characters

H
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General
Sources

Printer
Format

Character
Spells

Show Full Sheet
Create Icons

Screen Mode
Font

Program
Character
Palette

Load Settings

Save Settings

1.70 settings_character

Different options that changes the way CharGen works.

options

are saved along with the character. If you select no options, the
program will work in accordance with basic PHB rules.

Slow, unlimited advancement
Less damage on tiny thrown wpn.
Race affects years/level ratio
No bonus for strength on bows
High prime affects max. level
Do not limit AC from -10 to 10
Weapon style spec. allowed
Piecemeal armors allowed

All warriors can specialize

These

(_7
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1.71

No maximum on thief skills
Multiple weapon specialization
Long equipment lines

Spec. bonus on missile weapons
All classes allowed

Initiative adjusted by dex.
All armors allowed

Initiative adjusted by armor
All weapons allowed

All races can have Excep Str
All proficiencies allowed

No extra proficiencies for Int
All spells allowed

Int 13 for Thought and Numbers
All priesthoods allowed
Maximum hp on first level

All wizard schools allowed

Generous hp calculation method

settings_character_slow

This optional rule from DMG allows multiclassed demihumans to
The slow advancement

advance above their normal maximum level limit.
rate can be changed by you in the

Settings/General
~menu.

1.72 settings_character_race

highest age catagory of the race,
this is not selected the adjustment to age is independant of race.

Choosing this option makes CharGen adjust the age according to

the

and the level of the character.

<_>
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Generally, the longer lived races takes more years to advance. The
year/level ratio can be changed by you in the
Settings/General
menu.
1.73 settings_character_high
This optional rule from DMG allows demihumans to have higher maximum
level limit than normal, if they have high prime requiste ability
scores.
1.74 settings_character_weaponspec
Use the rules for weapon style specialization as given in ’The
Complete Fighter’s Handbook’
1.75 settings_character_allwarriors
This is the rule from the ’'The Complete Fighter’s Handbook’, <

that
allows all warriors to specialize (an error ???). This is implemented
by allowing all classes, which have the ’'Weapon specialization’ and
"Max one weapon specialization’ options under ’'Design, Class, Options’
selected, to specialize. Please note that unless you also choose the

Multiple weapon specialization
option, the character
can only specialize in one weapon, unless he is a fighter.

1.76 settings_character_multiple

Allows all who can specialize to specialize in more than one weapon.

1.77 settings_character_spec.bonus

According to Players Handbook the +1 to hit and +2 on damage given
to weapon specialists only apply to meele weapons. This option allows
you to also gain these bonuses on missile weapons.
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1.78 settings_character_initiativedex

This is a rule I use myself. The speed of weapons are adjusted by
dexterity reaction adjustment. Thus a character with 17 dex gains a +2
bonus on initiative when fighting (see the effect on weapon speed).

1.79 settings_character_initiativearmor

This is a rule I use myself. Uses the dex check penalty for
armor

(from Fighter’s Handbook) as a penalty on initiative. This penalty can
be reduced by magical armor (each "+’ reduces the penalty by one,
although it cannot make the penalty into a bonus). Thus if a character
wore a Banded Mail + 1 (Banded mail has a dex check penalty of -2) the
penalty for wearing armor would be -1 on initiative (see the effect on
weapon speed). Shields do not affect initiative under this rule. Use
this rule as a counterbalance to the

Initiative adjusted by dex.

rule.

1.80 settings_character_excepstr

Normally halflings cannot have exceptional strength, so this option
is for your _very_ special halflings. If you design other races that
also cannot have exceptional strength, this option also affects them.

1.81 settings_character_int

Allows you to disable the rule from PHB that gives extra nonweapon
proficiency slots to characters with high intelligence.

1.82 settings_character_int13

A recomended rule from the Tome of Magic. It requires the character
to have 13 in intelligence before he/she can cast spells from the
Thought and Number spheres.

1.83 settings_character_maximumhp

The character gains maximum hit points on first level (i.e. no rolls
are nessesary). Use this option to create tougher characters, if your
campaign is especially ’"high-powered’.
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1.84 settings_character_generous

This method of calculation hit points for multiclassed characters is
more generous than the one given in PHB. The reason for this is mainly
that the routine rounds up instead of down, and you can add all rolls
before dividing by the number of classes.

My rule: All hit dice for each level divided by the number of
classes (round up) plus the most advantageous constitution bonus. When
you don’t advance simultaneously in all classes you only gain hit
points when your higest class level increases. Example: A 3/3 level
fighter/thief with constitution 17, who advances a level as thief gets
(d6+d10) /2+3 hit points. He gets no hit points when he later advances
to 4'th level as fighter.

1.85 settings_character_less

This is a rule I use myself. It does not grant a full damage bonus
for high strength, when the weapon is a very small thrown weapon (such
as a thrown knife). In these cases the program gives you half the
strength damage bonus (rounded down). By selecting this option you can
use this rule.

1.86 settings_character_nobonus

This option dissallows strength bonuses on bow attack roll and

damage. It is an option here, rather than Jjust under
Design/Weapon

4
so you can let some characters have heavy pull bows, while not
others.

1.87 settings_character_ac

CharGen normally limits AC to the 10 to -10 range. If you don’t want
these limits imposed, select this option.

1.88 settings_character_piecemeal

Use the Piecemeal armor rules from ’The Complete Fighter’s
Handbook’ .
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1.89 settings_character_nomaxthief

Normally thief skills cannot exceed 95% (99% for Rangers), but I use
a slightly different rule in my campaign (yes, yet a another rule ;-).

My rule: A thiefs skill _CAN_ exceed 95%, but if, when the skill is
checked, you roll 96% or above the skill check fails. Now you might
say that there is no practical difference between this rule and the
one in PHB, but there is: If the DM decides to penalize the characters
skill (e.g. because of a difficult lock) the penalty is deducted from
the characters skill before the roll is made. Thus if a thief with
105% skill in an ability gets a —-20% penalty he would have a 85%
chance of succeding, whereas a thief under PHB rules (max 95% skill)
would have 75% chance of succeding.

1.90 settings_character_longequipment

Causes the equipment lines to be twice as long, but there will be
half as many of them. Changing this option might loose you some of the
equipment information you have already entered (especially if changing
from short to long lines).

1.91 settings_character_allallowed

This option is for when you want to create a character that goes
beyond the normal rules of the game (i.e. a halfling using large
weapons, a human fighter/mage etc....). It doesn’t override you source
settings.

1.92 settings_new_characters

Here you can edit the options new characters will be given. For <+
an
explanation of how these options work, check out

Settings/Options/This character

1.93 settings_general

Here you can edit the way ability scores are rolled, and a few
numbers, CharGen uses:

Ability Score Methods:
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Ability scores (humans)
Ability scores (non-humans)
Custom Method

Magic Numbers:
Slow level increase factor
Years/level ratio (Humans)

Random placement of scores

1.94 settings_general_ability human

Here you choose which method should be used when rolling ability

scores for humans. If you choose ’"Custom’ the program will use the
information you have entered in the

Custom Method

boxes.
The following methods have been implemented: PHB 1, PHB 2, PHB 3, PHB
4, PHB 5, UA and Custom.

1.95 settings_general_ability_non

As
Ability Scores (Humans)
, but for non-humans. This division
between humans and non-humans is nessesary in order to use the UA
method correctly. This method can only be used for humans according to
the rules (although many people use it for all races, even
multiclassed characters).

1.96 settings_general_custom

The following numbers define the custom method of rolling ability
scores.

"Rolls’

"Type of dice’

"Number of dice per roll’
"Number of dice to use’
"Added to result’
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1.97 settings_general_slow

An optional rule from DMG allows multiclassed demihumans to
advance
above their normal maximum level limit. The slow advancement rate can
be changed here. For this to work you must have the

Slow, unlimited advancement
option selected.

1.98 settings_general_years

This is the number of years added to a humans age for each level he
has achived, when creating random characters.

1.99 settings_general_random

When rolling a random character, the scores rolled are placed on the
different abilities according to their relevance to the race and class
of the character. The degree to which this placement of scores should
be random, can be controlled with this number. A very low number
assures that Fighters will have high strength, Thieves high dexterity
and so on... Please note that the race of the character also affects
the distribution of the scores, so a Halfling Fighter is also likely
to have a high dexterity. The higher the number, the more random the
placement of the highest scores will be. This does in no way change
the value of the rolled scores, only on which ability they are placed.

1.100 settings_sources

This menu-item also allows you to tell the program which source
books are available to you. A selected book will be available, and an
unselected book unavailable. Do not delete any of the books already
entered, as this can cause trouble in future versions. You may rename
the books, but keep the name of any source book that contains spells
short, so that it can fit when you print the spells.

The information you enter here is checked against each items’s
"Source Book’ field to determine if the item is available or not.
Items that are not available will be ghosted, when you select from
among that type of items.

The following items have sourcebook information in the present
version of CharGen: Armors, Proficiencies, Spells, Weapons, and
Psionics.

The use of the source book fields will perhaps later be extended to
other things.

(_)
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Here follows a list of the source books already in CharGen. Some of
the sources are not yet used, but are included for completeness.

<YOU>

Bard’s

Dragon

Dragon Kings
Fighter’s

FRA

Forbidden Lore
GA

Legends & Lore
Lost Ships

This is for your own creations.

Change the name to something else, if you like.

The Complete Bard’s Handbook.
Dragon Magazine.

Dragon Kings (Dark Sun).

The Complete Fighter’s Handbook.
Forgotten Realms Adventures.
Forbidden Lore.

Greyhawk Adventures.

Legends & Lore.

Lost Ships (Spelljammer accessory) .

Fortress A Mighty Fortress

PHB Player’s Handbook.

Private This is one of my (or my players) creations.
Psionics The Complete Psionics Handbook.

Ravenloft Ravenloft (boxed set).

The Complete Spacefarer’s Handbook (Spelljammer).
Spelljammer (boxed set).

Spacefarer’s
Spelljammer

Thay Dreams of the Red Wizards (Forgotten Realms).
Thief’s The Complete Thief’s Handbook.

Tome Tome of Magic.

UA (l.ed) Unearthed Arcana (lst edition).

War Captain’s Companion (boxed set, Spelljammer).
The Complete Wizard’s Handbook.

War Captain’s
Wizard’s

1.101 settings_printer

Allows you to change the print destination from the standard PRT <
(this means you can print to a file, if you enter a file name).
Printer options:

"Send form feeds to printer’
Selecting this option sends form feeds to the printer when printing
to PRT:.

"Remove printer codes when not printing to PRT:’
When you print to a file you often don’t want the printer escape
codes printed also. Choose this option to remove the escape codes.

"Print description, notes and equipment on seperate sheet’
Makes sure the description, notes and equipment are not printed on
the main character sheet, even though they may be seen on screen.
You should use

Project/Print Description

to print these data on a
seperate sheet of paper.

"Reading guides on spell or psionic lists’
Makes CharGen underline every third line printed on spell or psionic
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lists, to make the list easier to read (no need to use a ruler to
keep your eyes on the same line).

1.102 settings_format_character

Sheet Configuration:

Vertical Character
Horizontal Character
Sheet Length
Sheet Options:
Use SI units
Show full description
Show notes and egquipment
Show Armor Data
Show To Hit adjustment
Empty lines on Sheet:
Weapons
Proficiencies
Special abilities

Notes and Equipment

1.103 sheet _vertical char

Here you can enter the character to be used to draw vertical lines
on the character sheet. If you enter nothing, no vertical lines will
be drawn.

1.104 sheet_horizontal_char

Here you can enter the character to be used to draw horizontal lines
on the character sheet. If you enter nothing, no horizontal lines will
be drawn, but text will still be underlined.




CharGen

35/42

1.105 sheet_length

The maximum length of the character sheet. From 50 to 100 lines. If
you use a very short sheet, chances are that some information will be
left out at the bottom.

1.106 sheet_si

Use cm and kg instead of inches and 1lbs. on the sheet and under

Edit/Description
Please note that inches and lbs. are always
used in
Design

1.107 sheet_full

Show the full description on the sheet. Only lines that contain
information are shown.

1.108 sheet_show notes

Show notes and equipment (other than weapons and armor) .

note, that CharGen might have some trouble fitting all the information
onto the sheet, if you use this option and the option
Show full description

1.109 sheet _show armor

Show special armor data, as defined in ’'The Complete Fighter’s
Handbook’, on the character sheet.

1.110 sheet_show to hit

Show the To Hit adjustment on the character sheet in the ’"Hit’ colum,
instead of the THACO.

Please
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1.111 sheet_lines_weapons

How many empty weapon lines do you wish to have on the character
sheet ?

1.112 sheet_lines_proficiencies

How many empty proficiency lines do you wish to have on the
character sheet ?

1.113 sheet_lines_special

How many empty special ability lines do you wish to have on the
character sheet ?

1.114 sheet_lines_notes

How many empty notes and equipment lines do you wish to have on the
character sheet ?

1.115 settings_format_spells

This is where you define the user definable spell printing formats.

Using the ’'Data Format’ boxes on the left side of the screen, you
can edit the way spell data is printed, when using the ’User defined
format’ print method.

Using the ’'Column Format’ boxes on the right side of the screen, you
can edit the width the lines and spell names, when using the ’'Names in
x columns’ print method.

The editable number boxes define how wide the data field in question
is. You can change this within certain limits. The recessed ’'Width’
boxes show the total width of a line (in characters), excluding any
margin you might have set in printer preferences, and the print pitch
that will be used when printing. CharGen selects the print pitch
(Pica, Elite or Fine) based on the widths, and the left and right
margins you have set in the printer preferences.

1.116 settings_show

Should the full character sheet be visible on the screen?
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1.117 settings_icons

Selecting this will make CharGen create icons for any character it
saves.
1.118 settings_screenmode

Allows you to pick the screen mode CharGen will use. The screen mode
and screen size are saved in the Settings file, along with window size
and position. Is only available under 2.0+.

The screen opened by CharGen is a public screen with the name
"CHARGEN.1l’. If CharGen is run again the new screen will have the name
"CHARGEN.2’ and so on...
1.119 settings_font_program

Allows you to pick the font CharGen will use throughout the <«

program,

except for the character sheet (see
Settings/Font/Character
) .

Although available font sizes will depend on the size of the screen
CharGen is on, it can still happen that some text or gadgets ’crawls’
out of the window, so after changing fonts, CharGen will resize the
window so that this is unlikely (when possible - if you use large
fonts it might be unavoidable). The program font can be proportional.

1.120 settings_font_character

Allows you to pick the font CharGen will use for the character
sheet. The ’'Character’ font must be fixed width.

1.121 settings_palette

Allows you to change the programs colors. The color change is
permanent if you save the settings.

1.122 settings_load

Loads settings file (including sources) .




CharGen 38/42

1.123 settings_save

Saves settings file (including sources).

1.124 tooltypes

These tool types can be placed in the CharGen icon using the <
Info
(Information under WB 2.x) item in the Workbench menu. You can also
use these tool types if you run from shell (perhaps from the startup-
sequence of a boot disk), Example:

CharGen PUBSCREEN=Workbench PROGRAMFONT=topaz/1l1l

PUBSCREEN
PROGRAMFONT
CHARACTERFONT
SETTINGS
CHARDATA
CHARACTERS
SCREEN

NOSIZE

1.125 tool_pubscreen

Usage: PUBSCREEN=<screenname>

Tells CharGen to open its window on the public screen named (case
sensetive!) .

Example:

PUBSCREEN=Workbench

1.126 tool_programfont

Usage: PROGRAMFONT=<font>/<size>

Selects the
program font
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Overrides the font saved in the
Settings file. Do not include ".font" in the font name.

Example:

PROGRAMFONT=helvetica/13

1.127 tool_characterfont

Usage: CHARACTERFONT=<font>/<size>
Selects the
character sheet font
Overrides the font
saved in the Settings file. Do not include ".font" in the font name.

Example:

CHARACTERFONT=courier/13

1.128 tool_settings

Usage: SETTINGS=<file path>
Allows you to specify a different settings file to use.
Example:

SETTINGS=work:AD&D/SpellJammer/CharGen.prefs

1.129 tool chardata

Usage: CHARDATA=<directory path>

Allows you to specify a different directory from which CharGen will
get its data about races, classes,... This is useful if you run
several campaigns which differ greatly in races, classes, ...

Example:

CHARDATA=work:AD&D/SpellJammer/CharData

1.130 tool characters
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Usage: CHARACTERS=<directory path>

Allows you to specify a different directory to which CharGen will
save the characters you create. This is also useful if you run several
campaigns.

Example:

CHARACTER=work:AD&D/SpellJammer/Characters

1.131 tool screen

Usage: SCREEN=<NTSC|PAL|LACE> (not 2.0+)

Force screen mode selection. The program detects weather the machine
run in PAL or a NTSC mode, so this tool type is not nessesary for the
ordinary user, but it helps me when I have to check the Gadget layout
on an NTSC screen. The LACE option can be used with NTSC and PAL in

this way, but is not required:

SCREEN=NTSC | LACE
SCREEN=PAL| LACE

or it can be used alone
SCREEN=LACE
If you run in NTSC mode and have an anti-flicker device, then I
strongly recommend that you use the LACE option, as the screen layout

improves (more room for all the gadgets, see also NOSIZE).

If you use the LACE option you might consider using a larger font,
such as topaz 11, so the text will be easier to read.

1.132 tool nosize

Usage: NOSIZE

If you run CharGen in NTSC, you should use this tool type to remove
the sizing gadget in the lower right corner of the window. The gadget
layout on a NTSC screen was created with the assumption that you use

this tool type. This tool type can of course also be used if you don’t
run in NTSC, giving you a little more room in the window.

1.133 limitations

The program imposes the following restrictions on the number of:

Races: 32
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Single Classes:
Classes:
Armors:
Weapons:
Proficiencies:
Wizard Schools:
Priesthoods:
Spells:

Psionic Powers:

This should be enough to for most people.

1.134 contacting

32
80
80
250
250
250
250
2000
500

If you have ideas for things that could improve the program,
you find any bugs, please write to me, either via email:

E-mail: troels@scala.ping.dk

FidoNet: 2:235/419.35 (Troels Poulsen)

or normal mail:

Troels Poulsen
P.W. Tegnersvej 46
3070 Snekkersten
Denmark

Please include the following information:

CharGen version.

0S version (1.3, 2.0, 2.1..... ) .
Computer.

Detailed description of bug/symptoms if you write a bug report.

1.135 support

The latest version of CharGen (CharG1l17.lha)
BBS where I am point (changed since last vers

Doom Amigs BBS

Sysop: Bjarke @rbeck
Fido: 2:235/419.0
Place: Copenhagen

Phone: (+45) 36 48 68 83

1.136 thanks

Thanks to

Lars Meldgard for his useful suggestions,
converting the doc to amigaguide format.
Claus Lykke for his useful suggestions.
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testing,
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Rasmus Hansen for typing in all psionic powers, and the
spells from ’'Forbidden Lore’.

Victor Alvarez for typing in gods from Forgotten Realms
Adventures, and a few weapons.

Nico Francois for the ReqgTools.library

Thomas Agatz for being my Boss on Pitstop BBS.

Rolf Max Rotvel for CharGen support on Wintermute BRBS.
All others who have written to me with suggestions and/or
bug reports.
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